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WelcomeWelcome

Welcome to the world of the Dios.Dios chips, modules and boards are tiny computers (microcontrollers)
complete with memory and IO ports.  They have built-in hardware features such as timers, PWM generators
and an interrupt driven hardware UART.  Some modules and boards have built in regulator and PCinterface.
The Dios Ultra Board even has a built in LCD interface as well as provisions for buttons, EEprom, and Real
Time Clock.

The Dios provides 22-33 IO lines depending on the chip, module or board used.  They have a built-in command
set capable of running several thousand instructions per second.  Several interrupts and in-line assembly are
supported.
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Using the Dios Editor

Introduction

In order to program the Dios chips and modules you will need the Dios software.  This software
is free and can be downloaded from the Kronos Robotics web site at www.kronosrobotics.com.

The Dios Editor may also be used with the DLC.  When used with the DLCthe functionality is
identical save for a few options available to the DLC on the compiler form.

The Dios Editor Software has many utilities to help you manage your files and libraries.  There
is even a conversion utility to help you do binary, hex and decimal conversions.

The Dios Editor is also used to upgrade the Dios Chips.

http://www.kronosrobotics.com
http://www.kronosrobotics.com
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Installation

Figure 1.1: File Manager

System Requirements

•266Mhz system
•Windows 98,Me,NT4,2000,XP
•64Mb of Ram
•20Meg Disk Space
•CD-ROM if loaded from CD
•Internet connection if downloaded from Website
•Serial port capable of 115200 speed.  
•Graphics Card capable of 800x600

Software Installation

Insert the CD into CD-ROM.  The installation will start automatically.  Once installation starts
follow the instructions. If auto insertion is turned off you will have to manually install the
software.  To do this open up the CD-ROM drive and double click the program labeled
DiosSetup.exe.

If you are installing over top of a previous version then you must remove the old version first.
You will be prompted with three options.  Select the Remove option and click next.  Once
removal is complete, reinsert the CD and install as normal.

Note: if prompted to remove shared components, answer yes and continue.

Using the Software

When the Dios Editor is
started the Dios File
Manager form is loaded.

This form is used to keep
track of the last 50
programs that you have edited.

Recent Files

Each time you edit a file it will be placed in the file list box.  All other files in the list box will
be shiffted down.  If the file is already in the list box it will be moved to the top of the list.  To
load the file just hit the <- Load button. 

As a special feature the Dios will keep track of the window size and location of each of the
last 50 files located in the list box.

Minimizing the Dios Software

When you minimize the Dios File Manager all Dios Forms will be minimized.   Once the File
manager is restored all the minimized forms will be as well. 

File List Box

http://www.kronosrobotics.com
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Quick Loads
When you shutdown the Dios software it will remember what forms were open and thier
locations.   They will all be opened in the same position.  This will allow you to take up where
you left off during your last session.

Quick Loads

There are 10 quick load menu selections.  You can use these to place 10 of your most used
programs or templates.

To place a file into one of the quick load locations use the Edit Quick Load option under
the Quick Loads menu.

Once you have selected a menu item to change you will be presented with file selection
form.  Highlight the file you would like to place in the Quick Load and click OK.

Use Edit Quick Load

Then select the menu
item you wish to load

Figure 1.2: Quick Loads

Figure 1.3: Quick Loads File
Selection Form

http://www.kronosrobotics.com
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Change Com Port

Once you have loaded your Quick Load menu items It’s as simple as picking the item from
the list.  You can also use one of the hot keys any time the Dios File Manager is active.

You can also open an existing file or create a new one by using the New Dios File and
Open Dios File options under the File menu.

Changing the Com Port

There are times when you may need to change the com port your PCuses to communicate
with the Dios Ultra and the DLC.   This is done with the Change Com Port option in the
Settings menu on the File Manager.

To test the com port for proper operation connect a Dios Ultra or DLC to the PC and select
a port to test.   Click the Dios Test button.  If the PCdetects a DLC or Dios Ultra the test will
pass.  If not you will get a fail message.

Figure 1.4: Select a Quick
Load menu item

Figure 1.5: Select Change
Com Port

Figure 1.6: Change Com Port

http://www.kronosrobotics.com


Using the DiosPro Editor

Using the DiosPro Editor • www.kronosrobotics.com Page 11

Upgrade The Dios Firmware

Changing Dios Debug/Program Port

There are times when you need to change the Debug/Program port on a particular Dios
Chip.  

You can select IO port 16 or IO port 3 for the transmit debug port.  This applies to the current
chip being programmed.

Note that if you change the port on any of the Dios Ultra modules or boards you will need
to change the appropriate jumper settings on the Dios Ultra Board.

Upgrading the Dios Ultra

Each time the Dios Editor software is upgraded, the firmware of each chip must be upgraded
as well.  If it is not upgraded there is a good chance the chips may not function properly with
the new editor software.

To upgrade the software select the Upgrade Dios Ultra Firmware option from the File
menu.

Important
•Always disconnect all external components such as motor controllers and other IO devices
from the Dios Ultra chips before upgrading.  
•Always stop all other process on your PC while updating your firmware.

Once the Dios Ultra chip is connected, just click the Upload Firmware button.  When all your
Dios Ultra chips are upgraded, click the Quit button to close the form.

Figure 1.8: Dios Ultra
Upgrades

Figure 1.7: Change Debug
Port

http://www.kronosrobotics.com


Using the DiosPro Editor

Using the DiosPro Edtior • www.kronosrobotics.com Page 12

Dios Libraries

Figure 1.13: Library Manager

Dios Libraries

One of the most powerful features of the Dios is the use of libraries.  

Libraries make the job of creating reusable code very easy.  Libraries are just  normal Dios
files with a .lib extension.   By placing them in the lib directory they will automatically be
managed by the Dios Libraries Manager.

To activate the library, select the Libraries item in the Utilities menu of the Edit form.

Dios Library Manager

When you double click on an item in the library list the help file will be loaded and presented.
A Windows help file is looked for first.  If not found a .txt file is looked for and presented.  If
no help file is located an error message will be presented.

When you click the Create Include button it will place the correct include statement into the
windows clipboard so you can paste it into your program.

To use the Create Include button first select the library from the list.  Then click the Create
Include button.  Paste the the new include statement into your document.  Normally we
place libraries at the end of the current file.

You can also edit a library file by selecting it from the list and hitting the Edit Library
button.

Note: If you use one of the functions included with the Dios Software and forget to add the
include file it will be added to you source code automaticaly.

Figure 1.14: Double clicking on
a, include file name will auto-
maticly load that file in an edit
form.

http://www.kronosrobotics.com
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Change Edit Form Colors

Changing the Edit Form Colors

You can change the foreground (font) and background color of the edit form by selecting
the color menu items under the Settings menu.

This will pop up a color form.  Select the color for the background or font.

If you want the colors to become permanent make sure you save the settings.  This option
is located in the settings menu.

Figure 1.15: Change Edit
Form Colors.

Figure 1.16: Color Picker

http://www.kronosrobotics.com
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Conversion Utility

Conversion Utility

There is a built-in number conversion utility that will allow you to convert Hex, Decimal
and Binary numbers.  To load the conversion form select the Conversion menu item from
the Utilities menu on the Edit Form or File Manager.

The conversions are automatic.  When you make a single digit change to any field all
other fields will be updated.

We have also added the ability to do some basic math.  Simply add an oppered to the
math filed and hit one of the math keys.

Figure 1.17: Select
Conversion on Utilities menu.

Figure 1.18: Number
Conversion Form

http://www.kronosrobotics.com


Using the DiosPro Editor

Using the DiosPro Editor • www.kronosrobotics.com Page 15

Utility Terminial

Utility Terminal

The Utility Terminal is a simple communications terminal that allows you to set the baud rate.
The other settings like data bits, parity, and stop bits are hard coded to 8N1.

To use the terminal select the baud rate and com port.  The port must be an available port
on your PC.  It cannot be the same as the com port used for the debug terminal.

Once selected click the Open button.  Once open, anything that is received will be displayed
in the main text window.  If you type a character in the main window it will be transmitted.
You can also place ASCII values in the five small fields. Hit Send and the data will be
transmitted.

Edit Form Overview

When you create a new DiosPro file you will be presented with an almost empty form. The
actual contents of the new file is created from a file called template.txt located in the Dios
directory.  You may change this file to change the startup template if you wish.

Figure 1.19: Edit Form

Figure 1.20: Utility Terminal

http://www.kronosrobotics.com
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Command Syntax Help

By using the items in the File menu you may save or print the contents of this form.  You
may also load a new file into this form.

You can also locate items in the form by using the Find and Find Next options in the Edit
menu.  Click the Debug Terminal menu to pop up the debug terminal.

The Utility Terminal, Library Manager and Conversion Utility can be accessed by selecting
them under the Utility menu.

The Help menu presents you with the same help information as the File Manager.

Using the Edit Form

Use the edit form by placing the mouse in the form and typing.  To compile your file, click
the Compile button. the main difference between the Compile and Program buttons is that
when the Program button is hit the Dios Ultra or DLC will be programmed once the compile
process is complete.

Command Syntax Help

Any time you want some help about command, simply select the word and hit F1.  A help
form will pop up with a complete definition of the command.

If the word selected is not a valid command you will get a generic help form.

Figure 1.21: Command Help

Important

There is a current 64K text
size limit in each Edit form.
Once you file starts to approch
this size simply place some of
your functions in an include
file.  

http://www.kronosrobotics.com
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Saving a File

Saving a File

To save a new file select the Save As in the File menu.

The Save File form will pop up.  Select the directory and type in a file name.  Always use an
extension of .txt or .lib for your files.  Once a location and file name is selected click the Save
File button.

Once the file has been saved the name of the file will be displayed at the top of the form. 

The name will also be displayed on the top button on the File Manager.

Once a program is given a name, whenever that program is compiled or programmed it is
saved automatically.

Compile Form Overview

When you compile or program a chip, the Dios Compiler form will pop up.  This form
presents you with various pieces of information about the compile process.  If you are
programming, the status of the program upload will also be shown.

The Programmer menu displays commands for resetting and powering the target chip.
These features are used during in-circuit programming with the DLC.  Under the Settings
form you can enable the auto verify process.

Note that the program upload process will only begin if the compile does not encounter an
error.

Figure 1.22: Save File Form

http://www.kronosrobotics.com
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Compile Errors

Handling a Compile Error

When you encounter a compile error, click the Go to Last Error button.  

The cursor will jump to the location in the file where the error was encountered

Figure 1.23: Compiler Form

Figure 1.24: Compiler Error

http://www.kronosrobotics.com
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Debug Terminal

Note If the error is in an include file the cursor will jump to the include file definition.  Double
click this definition and the Include file will open.  Click the Go to Last Error in that file and
the cursor will jump to the error in that file.

Debug Terminal

Any time you use the debug or print commands the software will activate the debug terminal.
The debug terminal is set to 115200 baud.  This is the baud rate used to communicate with
the Dios Ultra and the DLC programmed chips.

By default, any character with a ASCII value less than 32 will be placed in <> and displayed
as such.  If you wish, you can force all characters to be displayed in raw format by selecting
the raw check box.

You can disable the terminal by clicking the disable check box.  Note that the display field
can only hold about 20,000 characters, so it is automatically trimmed.  By disabling the
terminal it freezes the display.

Debug and Interrupts

The timing used to generate debug and print commands are very precise and an interrupt
operating in the background can sometimes throw this timing off.  Many other
microcontrollers don't suffer from this anomaly because they don't support true interrupts
like the Dios does.  In order to work around this issue check out the interrupts section.

Figure 1.25: Debug Terminal

http://www.kronosrobotics.com
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Introduction         

There are currently 6 hardware form factors.  Don’t worry, the language is
exactly the same for all of them. It is simply a matter of what features and the
number of IO ports that are made available.

Dios Hookup

http://www.kronosrobotics.com
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Dios 40 Pin Chip

Form Factor: .6 x 40 Pins

IO Ports: 33

Analog to Digital Lines: 8

Program memory: 16/16K

Power Source: 3-5.5v DC

EZRS232 Driver required.  Check Appendix G to
build your own.

Required Componets:
10Mhz Resonator
10k Resistor
10uf Capacitor
.1uf Capacitor

DiosPro Hookup

http://www.kronosrobotics.com
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Dios 28 Pin Chip 

Form Factor: .3 x 28 Pins

IO Ports: 22

Analog to Digital Lines: 5

Program memory: 16/16K

Power Source: 3-5.5v DC

EZ RS232 Driver required.  Check Appendix G to build your own.

Required Componets:
10Mhz Resonator
10k Resistor
10uf Capacitor
.1uf Capacitor

Dios Hookup

http://www.kronosrobotics.com
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Form Factor: .6 x 40 Pins

IO Ports: 33

Analog to Digital Lines: 13

Program Memory: 16/48K

Power Source: 2.5-5.5v DC

EZRS232 Driver required.  Check Appendix G to build your own.

Required Componets:
10Mhz Resonator
10k Resistor
10uf Capacitor
.1uf Capacitor

http://www.kronosrobotics.com
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Form Factor: .3 x 28 Pins

IO Ports: 22

Analog to Digital Lines: 10

Program memory: 16/48K

Power Source: 3-5.5v DC

EZ RS232 Driver required.  Check Appendix G to build your own.

Required Componets:
10Mhz Resonator
10k Resistor
10uf Capacitor
.1uf Capacitor

http://www.kronosrobotics.com
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Dios Carrier  #1

Form Factor: .6 x 32 Pins

Chip Used: Dios 28 Pin Chip

IO Ports: 22

Analog to Digital Lines: 5

Power Source: 2.5-5.5v DC

EZ RS232 Driver required.  Check Appendix G to
build your own.

Required Componets:
None

Options:
5V Regulator

You can set the transmit program lead by
changing the jumper as shown.  Remember
you also must set the port in the software as
well.

DiosPro Hookup

The Dios Chip is not included with the Carrier.  They are sold seperatly.

Dios Carrier #1

DiosPro

http://www.kronosrobotics.com


Form Factor: 2-5/8” x 1-7/16” board

Chip Used: Dios  28 Pin Chip

IO Ports: 22

Analog to Digital Lines: 5

Power Source: 2.5-5.5v DC / 7 - 14v with Regulator Option

EZ RS232 Driver required.  Check Appendix G to build your own.

Required Componets:
None

Options:
Regulator, External Timer Clock

Dios Carrier #2

Connecting the Dios Carrier #2 board to the PC

There are 2 RS232 Drivers available from Kronos Robotics.  If you wish to
build your own see Appendix A.

Both the EZ232 and EZ232B drivers are available on the Kronos Robotics
web site.  See them at:

http://www.kronosrobotics.com/detail.asp?product_id=EZ232
and
http://www.kronosrobotics.com/detail.asp?product_id=EZ232B

To use one of the EZ drivers,  plug it into the program port as shown in
figure 8.

If you build your own driver use connections shown in figure 7.

EZ232 EZ232B

- 
A

tn

- 
Tr

an
sm

it

- 
Re

ce
iv

e

- 
5v

dc

- 
Vs

s

Program Port

Figure 6

Figure 8
Figure 7

The Dios Carrier #2 was designed to run as a
coprocessor.  There are libraries for both master
and slave devices included with the Dios software.
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DiosPro Hookup

The Dios Chip is not included with the Carrier.  They are sold seperatly.

http://www.kronosrobotics.com/detail.asp?product_id=EZ232
http://www.kronosrobotics.com/detail.asp?product_id=EZ232B
http://www.kronosrobotics.com
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Notes

DiosPro Hookup
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DiosPro Hookup

You will need a level converter chip.  I recommend the ST232ACN as it will work at speeds up to 250K baud and will
accept .1 uf or 1uf capacitors.  

The Kronos Robotics Part number for this chip is MAX1 and can be purchased at
http://www.kronosrobotics.com/detail.asp?product_id=MAX1

With the ST232ACN you can use ether .1 or 1 uf capacitors for C1-C4.

Note that the Dios Transmit port can be IO port 16 or port 3. On the Dios Carrier 1 and Carrier 2 boards this is
jumper selectable. You must set it up via the Dios Software. 

Dios Carrier 1  and Dios Carrier 2 Port Pins
· Dios Tx Port 16 = Pin 4
· Dios Rx Port 17 = Pin 3
· Dios Atn = Pin 5

Creating Your Own RS-232 Driver

http://www.kronosrobotics.com
http://www.kronosrobotics.com/detail.asp?product_id=MAX1
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ACUMEH
ACUMEL
ADCON0
ADCON1
address
addressreadi
addressreadf
addresswritei
addresswritrf
ADRESH
ADRESL
arrayget
arrayset          
ASMDAT...
AtoDinit
AtoDinitlj
and
auto
bintodec
bit   
BITCOUNTER
BITDATA
branch          
break        
BSR
BSR_TEMP
Button
BUTTONFLAG1
BUTTONFLAG2
BUTTONFLAG3
Buttoninit
byte     
BYTE...
CCP1CON
CCP2CON
CCPR1H
CCPR1L
CCPR2H
CCPR2L
CelsiustoF
clear          
clk165
clk595
CMDSTAT
COUNTER
COUNTERH
CPcidx
CPCMD
CPdat01
CPdat23
CPdat45
CPdat67
CPdat89
CPgetstatus
CPhigh
CPinit
CPinput
CPio...
CPlen
CPloaddefaults
CPlow
CPMotor...
CPoff
CPon
CPoutput
CPreadEEprom
CPrxcount
CPrxset
CPsend
CPsendbytes
CPServo...
CPslave
CPslaveinit
CPstat

CPtxcount
CPtxoff
CPtxset
CPTYPE_ID
CPver
CPversion
CPwriteEEprom
CUSTOMBIT...
CUSTOMMASK
customportget        
customportset        
dat165
dat595
data                 
debug         
DEBUGPADH
DEBUGPADL
DEBUGTX
dec
decmask          
DELAYCOUNT2H
DELAYCOUNT2L
DELAYCOUNTH
DELAYCOUNTL
dim  
DIOSFLAGS1        
DS1302CLK
DS1302getbyte
DS1302getdate
DS1302getday
DS1302gethour
DS1302getmin
DS1302getmonth
DS1302getram
DS1302getrawbyte
DS1302getsec
DS1302getyear
DS1302init
DS1302IO
DS1302RST
DS1302sendbyte
DS1302sendreg
DS1302setcharger
DS1302setdate
DS1302setday
DS1302sethour
DS1302setmin
DS1302setmonth
DS1302setram
DS1302setsec
DS1302setyear
DS1620H
DS1620init
DS1620NEG
DS1620readtemp
DS1820quicktemp
DS1820readtemp
EADDRESS
EEADR
EECON1
EECON2
EEDATA
eeread          
eewrite          
else
end
endasm        
endasmcommand        
endfunc
endfunction        
endif          
endirq        
endirqasm 
endsub     

exit          
exitirq          
for
FSR0H
FSR0L
FSR1H
FSR1L
FSR2H
FSR2L
func   
function 
floatmask
FLOATMASK1
FLOATMASK2      
G_LCDE
G_LCDRS
G_LCDRW
G_P0
G_P1
G_P2
G_P3
getbyte          
getstringbyte
global          
gosub          
HC165init
HC165read
HC165readx2
HC595high
HC595init
HC595low
HC595write
HC595writem
high          
hserfloat
hserin          
hserout          
HSERPADH
HSERPADL
hsersetup          
HSERWH
HSERWL
I2c_getack
I2c_getbyte
I2c_sendack
I2c_sendbyte
I2c_sendnack
I2c_start
I2c_stop
I2cin
I2cin2
I2cout
I2cout2
I2creadfloat
I2creadint
I2creadstring
I2cwritefloat
I2cwriteint
I2cwritestring
if
inc        
include          
INDF
INDF0
INDF2
INPIN
input
integer        
int        
INTCON
INTCON
INTCON2
ioport
IPR1

IPR2
IRcmd
IRdevice
IRkeypad
irqfunc          
IRinitsend
irqINT0...
irqINT1...
irqINT2...
irqLVD...
irqPSP...
irqRB...
irqSSP...
irqTMR0...
irqTMR1...
irqTMR2...
irqTMR3...
irqtx...
irqCCP1...
irqCCP2...
irqAD...
irqperipheralstart
irqperipheralstop
irqglobalstart
irqglobalstop
IRread
IRreadverify
IRsendcode
KBCLKpin
KBflags
KBflags
KBgetASCII
KBinit
KBIOpin
KBLEDupdate
KBread
KBreadraw
KBsendraw
lat595
LATA
LATB
LATC
LATD
LATE
LCDchar
LCDcharxy
LCDchkport
LCDcls
LCDcontrol
LCDgoto
lcdinit
LCDloadchar
LCDmegamenu
LCDmenu
LCDraw
LCDrawxy
LCDread
LCDtext
lcdwrite
lcdgoto
lcdcontrol
lcdchar
load165
lookdown
lookdownmode       
lookup          
low          
LVDCON
LVDinit
LVDread
MAX522CLK
MAX522CS
MAX522DATA
MAX522init

MAX522set1
MAX522set2
MCPset
MCPshutdown
mem...read
mem...write
next        
nop          
odhigh
odlow          
onirq          
OPP1
OPP10H
OPP10L
OPP2
OPP3
OPP4
OPP5
OPP6
OPP7
OPP8
OPP9H
OPP9L
or
OSCCON
output          
OWloadaddr
OWprintaddr
OWread
OWreadbyte
OWreadrom
OWreset
OWsendbyte
OWwrite0
OWwrite1
pause          
pauseus          
PCL
PCLATH
PCLATHU
PIE1
PIE2
PIR1
PIR2
PLUSW0
PLUSW1
PLUSW2
port595
PORTA
PORTB
PORTC
PORTD
PORTE
portget          
PORTMASK
portset          
POSTDEC0
POSTDEC1
POSTDEC2
POSTINC0
POSTINC1
POSTINC2
PR2
PREINC0
PREINC1
PREINC2
print          
printfloat
PRODH
PRODL
PROGADDRH
PROGADDRL
PROGLENH
PROGLENL

pullupoff          
pullupon          
pulsein          
pulseout          
PWM1duty
PWM2duty
PWMcourse
PWMinit
PWMperiod
random
randomize
RCON
RCREG
RCSTA
RECFLG
return          
RISA
RISB
round      
RSkeypadinit
RSkeypadread
RXDAT
RXHEAD
RXTAIL
SBBRG
serfloat
serin          
serout          
SERPADH
SERPADL
sersetup   
setfloatmask
setdecmask       
SERVO1
SERVO1
SERVO2
SERVO2
SERVO3
SERVO3
SERVO4
SERVO4
SERVOCOUNT
SERVOCOUNTER
SERVOinit
SERVOMAX
SERVOMAXCOUNTER
SERVORESET
SERWH
SERWL
shiftin          
sleep          
SOFTBAUDH
SOFTBAUDH
SOFTSTAT
SOFTWAITH
SOFTWAITL
sonar
SSPADD
SSPBUF
SSPCON1
SSPCON2
SSPSTAT
STACK1IDX
STACK2IDX
STACKTMP
startasm        
startasmcommand      
startirqasm      
STATUS
STATUS_TEMP
STKPTR
step
STRgetword
STRgetwrodaddr

STRinstr
STRlen
STRprinttext
STRval
strout
string
sub
swapbyte          
swapnib          
T0CON
T1CON
T2CON
T3CON
TABLAT
table   
TACUMEH
TACUMEL
TBLPTRH
TBLPTRL
TBLPTRU
then
TMP
TMP2
TMR0H
TMR0L
TMR1H
TMR1L
TMR2
TMR3H
TMR3L
toggle
TONE
TONEfreqout
TONEnote
TOSH
TOSL
TOSU
TRISC
TRISD
TRISE
trunc    
TXREG
TXSTA
VARBIDX
VARBSAVEH
VARBSAVEL
VERSION
W_TEMP
waitport
watchdogon
watchdogoff
WDTCON
wend
while
word
WREG
XHI
XLO
YHI
YLO

This is a list of reserved words used by the DiosPro Engine.  They are used for commands, functions, registers and vari-
ables.  Do not use them for your own commands, functions, labels, constants or variables.  If you do then expect unpre-
dictable results. 

Note that is some cases the ... is used.  This represents a wild card.  For example irqINT0... means don’t create any variable
or function starting with irqINT0.   These are reserved for future use.
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